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L Puaged Ty

' - =
Lynn Phillips 0 Perfecting Secretarial Writing Craft WI 1,000
Jim Fitch HS Basic Roofing Technology FL 1,309
Dale Weaver HS General Construction Cost Estimating CA 1,608
Karen Foskey S AC Design-Piping Systems WI 1,300
Keith Werner ) HS Air Conditioning-Piping Systems WI 1,300
Tommy Hankins HS Advance Energy Auditing VA 1,100

T. C. Weissenberger S Techniques for Integrating CAD WI 1,300 ‘
Larry Stallings (@) Air Conditioning Design WI 1,300
Larry Stallings ‘ﬁ Construction Estimating WI 1,000

|

Larry Stallings  J Creativity in Design WI 1,300 i

Larry Stallings " 4 Renovation of Buildings WI 1,000 :
Larry Stallings Single Ply & Built-up Roofing System WI 1,000
Jim Gavin HS NFPA Life Safety Code MD or SC 900
Fred Estes HS Air Installation Compatible Use Zones HS 600
Fred Estes HS Environmental Protection HS 600
Fred Estes HS Real Estate Seminar HS 400
Larry Brant HS Environmental Protection HS 600
Larry Brant HS Real Estate Seminar HS 400
(Phantom Planner) Facilities Planning 600
(Phantom Planner) Facilities Planning 600
(Phantom Planner) Economic Analysis 600
(Phantom Planner) Economic Analysis 600
John Jordan (0] Design Contract Mgmt VA 450
Mary Thompson o) Tecnhical Writing I VA 450
John Starcala Training AS/CPO CL 0
Brynn Ashton HS Concrete Technology MISS 1,000
Carl Baker 0 Design Contract Mgmt VA 450
Andrew Young (o} National Electrical Code NC 600
(Phantom Elec Eng) National Electrical Code NC 600
(Phantom Elec Eng) Coordination X 1,400
(Phantom Elec Eng) Microcomputer SC 700
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L ASHTON, Brynn T.
1 November 1985

TAD

PHILLIPS, Mary Lynn TAD

6-7 Nov 85

ESTES, Fred

BRANT, Larry

BAKER, Carl

ESTES, Fred W.

BRANT, Larry

PHILLIPS, Lynn

FITCH, Jim

ASHTON, Brynn

FY$b (10t 35- 30 Sep 86)

"One-day seminar presented by the U.S. Corps $157.20
P
of Engineers on "Design of Construction of Rolled

Concrete pavements...Norfolk, VA

2 days at LANTDIV to become familiar with more advanced 161.36 -
glossary functions to better utilize the NAVFAC GUIDE
SPECS and learn more about editing techniques

TRNG (MAIN money) To attend Special Projects Seminar, 550.00

Jacksonville, FL...14-15 Nov 85

TRNG (MAIN money) To attend Special Projects Seminar, 550.00

TRNG

TRNG

TRNG

TRNG

TRNG

TRNG

Jacksonville, FL....14-15 Nov 85

- "Military Traffic Operations & Analysis Techniques" 1136.50

Evanston, ILL 3-7 Feb 86

Economic Analysis Course, Leesburg, VA 24-28Mar ML;L/YN3LL°
Facilities Planner - Leesburg, VA  17-21Mar

- Air Installations Compatible Use Zones Seminar

East Coast...5-6Mar 86 Florida

Specifications & Construction Contracts
10-12 Mar 86....Boston, Mass

Facilities Support Contracting, Leesburg,
24-28 Mar 86

WI

vA wlf matie fbw?






NAME TYPE
PHILLIPS TRNG
PHILLIPS TDY
FITCH / ENERGY MONIES
FITCH TRNG
FITCH TDY
WERNER TRNG
WERNER TRNG
WERNER ENERGY MONIES
WERNER TRNG
HANKINS ENERGY MONIES
HANTINS ADD'L TRNG
MURRELL HDQTRS TRNG
MURRELL ENERGY MONIES
MURRELL TRNG
YOUNG TRNG
YOUNG ENERGY MONIES
BAKER ENVIRONMENTAL
ASHTON TRNG
BRANT "TRNG
BRANT PRNG
BRANT TDY
JONES TDY
ESTES DY

COURSE

WANG "Glossary"
LANTDIV

Energy Monitoring Systms
Design Contract Mgmt
LANTDIV

Pump & Valve Selection
Boiler Plant Design
Air Cond. Design

Prep for EIT

Fundamentals of Energy
Auditing

Leaking Underground Stg
Tanks

Air Conditioning Design
Design & Application
Prep for EIT

Advanced Coordination
Electronic Energy
Conservation Class

Low-Cost Shore Protection

Prep for EIT
Economic Analysis
Shore Fac Planning
Value Eng Conference

Value Eng Conference

Fac Conference

DATES

14-150ct84
9Jan85

11-15Mar85
15-16Apr85
14-15Apr

19-24Feb85
28-30Jan85
22-26Jul85
Course

25-28Mar85
16-20Sep85
15-19Apr85
10-12Jun85
Group
15-190ct84
25Feb85
26-27Mar85
Group
13-17May85
16-20Sep85
22May85

22May85

9-14Jun85

FY 85 TRAINING

LOCATION

Raleigh, NC
Norfolk, VA

Madison, WI
Norfolk, VA
Norfolk, VA
Madison, WI
Madison, WI
Madison, WI

Camp Lejeune, NC
Madison, WI
Madison, WI
Madison, WI
Skokie, ILL

Camp Lejeune, NC
Dallas, TX
Raleigh, NC
Madison, WI

Camp Lejeune, NC
Port Hueneme, CA
LANTDIV

LANTDIV

Arlington, VA

TOTAL

TOTAL .....$16,982.60

PWD
TRNG HDQTRS
MONIES ENERGY MONIES MONIES OTHER TDY
$ 245.00
$ 154.00
$1,300.00
350.00
$ 1lo0.00
$1,365.00
$1,190.00
$1,740.00
$ 120.00
$1,330.00
$ 935.00
$1,720.50
$ 665.00
$ 120.00
$1,651.00
225.00
$ 900.00 (Environmnt)
$ 120.00
$ 970.00
5 4, $ 117.00
$ 37.50
-~ 467.60
$8,166.00 $5,260.00 $1,720.50 $ 900.00 $ 936.10






Professional Development Programs in
Working Drawing Production and CAD Management

TECHNIQUES FOR INTEGRATING
CAD AND SYSTEMS DRAFTING TO
IMPROVE WORKING DRAWING

A shortc € designed to explore the procedures, techniques and benefits of utilizing
existing manual drafting systems with automation. Applications will demonstrate suc-
cessful implementation of the best procedures for improving production at all stages of
development. Sessions will explore:

* Advanced Systems—Manual Drafting—Overlay, Composite and Photographic

* Optimizing use of CAD and Systems Drafting

* Cost Effective Production Techniques §

* Overlay Systems Coordinated with CAD and Microcomputers

¢ Detail Banking Systems for Storage and Retrieval of Construction Information

¢ Coordinating and Integrating Production Systems for Architectural and Engineering Applications
* Quality Control of Working Drawing Production Systems

* Production Equipment and Materials Selection

APRIL 7-11, 1986—Madison, Wisconsin

EFFECTIVE MANAGEMENT OF
CAD SYSTEMS AND PRODUCTION

A workshop structured for “present” and “future” CAD managers to study:
* Effective Management Programs

e System Production Requirements

* Budgets, Profitability and Accountability

e Staff Needs and Organization

* Scheduling, Monitoring and Coordinating the Production Process

¢ Selection and Application of Software

¢ Planning the Work Environment

* Networking Systems for Successful Production

AUGUST 18-22, 1986-Purgatory/Durango, Colorado

Department of Engineering Professional Development

The Coliege of Engineering
University of Wisconsin-Madison




TECHNIQUES FOR INTEGRATING CAD-ANI

APRIL 7-11, 1986—MADISON, WISCE2X'SI!

PURPOSE
New graphic communication techniques are rapidly improving the
efficiency of working drawing production. For many firms, the
direct benefits are shown in time and cost savings. Some tech-
niques and systems are providing as high as 80 percent time
savings when compared to conventional production methods.
Innovation in the production of working drawings is greatly reduc-
ing the burden of drafting while allowing the design profession
more time for critical design activities.

A closer look at the emerging techniques provides levels of jus-
tification for most professionals to begin incorporating time sav-
ing systems. Many production personnel have selected approp-
riate innovations and maximized their benefits through system-
atic integration into the production department. Both small and
large organizations are experiencing new opportunities to make
improved design communication a marketable activity of the
design profession. The change to new systems is allowing aggres-
sive organizations fulfill greater time constraints presently being
dictated by today’s clients.

To advance in-house production programs requires planning,
cooperation and dediction toward researching new methods and
systems. The trial and error approach has brought about many
of the techniques presently in use by many firms across our na-
tion. Commitment to professional development has provided
firms with additional opportunities to exchange and evaluate new
techniques. This workshop is designed to study the ‘‘total
systems approach’’ to working drawing production and provide
participants with a hands-on opportunity to experience the use
of innovative techniques. Through the continuing education
workshop, firms can expect to:

1. Reduce failures in implementing innovative techniques;

2. Determine which methods are most appropriate for dif-
ferent types of projects;

3. Save time and money in streamlining production of
working drawings.

OBJECTIVES

* To demonstrate how new techniques can be integrated
into the production department.

* To identify steps for linking and networking new produc-
tion systems.

* To integrate overlay system effectiveness with comput-
er-aided production.

* To explore new techniques for storing and retrieving val-
uable construction information.

* To improve time and cost savings in working drawing
production.

WORKSHOP MANUAL

* A production manual, course notes, selected reference mate-
rials and working drawings for an actual construction project
will be provided.

1

PARTICIPANTS
This program is designed for architects, civil and mechanical,
engineers, landscape architects, interior designers, project man-
agers, job captains, educators, drafting personnel, reprographic
specialists and others responsible for innovating new techniques
in Working Drawing Production. Participants are encouraged to
bring production problems that may be applicable to CAD and
systems production techniques. These drawings will be analyzed
as part of the preparation process for utilizing the *‘total systems
approach’’ to production.

PRESENTATION FORMAT

* Equipment will be used in actual production setting.

* A special project will be used to demonstrate the ‘‘total systems
approach’’ to production from schematics to design develop-
ment to working drawings.

e Common production problems will be analyzed to demonstrate
successful solutions.

¢ A combination of lectures and workshops will be used to com-
municate production techniques.

DISPLAYS AND DEMONSTRATIONS

* Drawings, details and production information will be displayed
throughout the program.

* A computer workstation will be used to demonstrate CAD inte-
gration with systems drafting.

¢ Demonstrations comparing cost effective activities for overlay,
photographic and computer-aided production will be con-
ducted.

INSTRUCTORS

PAT BRUMFIELD, President, Lellyett & Rogers

Nation’s largest producer of offset muilti-color architectural/engi-
neering construction documents; Experience in developing
linkage between CAD and Systems Drafting. Nashville, Tennes-
see.

RONALD G. HOLDAWAY, P.E., Director of Automated Systems,
Smith Seckman Reid, Inc., Consulting Engineers, Chief Mechan-
ical Engineer with experience in management of the overall pro-
duction of mechanical, electrical and plumbing drawings using
a combination of systems drafting, CAD and traditional methods.
Nashville, Tennessee.

MICHAEL C. LENGYEL, Director of Project Management, Parkin
Architects; Former Project Manager, Cannell and Chaffin Com-
mercial Interiors; Instructor for Santa Monica City College on Ad-
vanced Systems Drafting and Computer-Aided Production;
Former Systems Drafting Consultant for Ford Graphics; Earlier
experience as Director of Advanced Design and Production Tech-
niques, Ronald T. Aday, Inc., Architects, Pasadena, California;
Los Angeles, California.

ED POWERS, Associate and Director of Quality Assurance,
Gresham, Smith & Partners, Architects-Planners-Engineers;
Author of Systems Drafting Manual for Reprographic Firms,
Systems Drafting Manual for Architectural Engineering Firms and
UNIGRAFS—A Systems Drafting Production Manual, 1981; 18
years experience in developing five levels of systems production
in working drawings; Nashville, Tennessee.




SYSTEMS DRAFTING TO IMPROVE WORKINGI

PROGRAM DIRECTOR AND INSTRUCTOR

PHILIP M. BENNETT, Architect; Program Director, Department
of Engineering Professional Development, University of Wiscon-
sin-Madison, Madison, Wisconsin.

PROGRAM 1
MONDAY, APRIL 7, 1986

A.M.

8:00 Registration
The Wisconsin Center
702 Langdon Street
Madison, Wisconsin

8:30 Welcome and Introduction
Philip M. Bennett
Program Director

8:45 What is a Systems Approach to Working
Drawing Production?
* Why have Advanced Drafting Techniques?

» Understanding the terminology

> A Systematic Approach to Design and Contract
Documents

» Enhanced Quality Control with Systems
Drafting

» The Most Common Errors in Implementing
Systems

» Extended Client Services

» How Contractors, Vendors, and Suppliers can
Utilize Overlay Drafting Techniques

» Management’s Responsibility
* Determining Goals
* Management Planning and Action
¢ Evaluating the Usefulness of a New

Production System

» Restructuring the Office Organization for
Systems
* Production Committee
¢ Production Coordinator
* The Graphic Assistant
¢ The Technical Work Center
* Reprographic Firm

» Components of Systems Drafting
* Overlay Drafting
* Composite Drafting
¢ Applique Drafting
* Photodrafting
¢ Lettering and Notation Systems
¢ Computer Drafting
* Reference Detail Drafting

» Introducing Systems Drafting to the Consultant
¢ Educating the Staff
* Quality Control of Drafting
* Preplanning of the Projects

3

10:15
10:45

12:00

2:50

» Support Components of Systems
e Staff Handbook
¢ Drafting Manual
e Code and Zoning Search
* Project Organization
* Quality Control Program

Coffee and Conversation

Developing Advanced Production Systems
¢ Applying Systems Drafting for Producing Working
Drawings
> Reviewing Present Production Methods
» Investigating New Materials, Tools, and
Techniques
» A new Priority—Quality and Accuracy in
Working Drawings
* Simplifying Working Drawings to Reduce
Repetition, Overdrawing, Cost, etc.
* Techniques Which Comprise Systems Drafting
» Overlay Drafting
¢ Materials and Methods for Overlay Drafting
* The Overlay Organizational Plan
* Indexing System
* Applying the Overlay Organizational Plan
> Registration System
» Cut and Paste Drafting
» Photodrafting
» Keynoting
» Final Printing of Construction Documents
* Diazo versus Multi-Color Printing
¢ Half-Size Diazo Printing
* A New Marketing Tool

LUNCH

P.M.

Workshop Exploring the Use
of Overlay Drafting
* A Systematic Approach to Overlay Drafting
* Develop a System of Base Sheets and
Overlays
* Never Draw Information More Than Once
* Registry Systems
¢ Composites for In-House Use
e Advantages
e Examples of Intermediate Materials
¢ Examples of Final Product
Offset in Color
Ozalid in Black and White
* Cost of Implementing The System
¢ Organization and Numbering for Overlay Drafting
» Divisional Format
e Section Breakdown
* Sheet Numbering
* Project Organization for Overlay Drafting

Refreshments




3:10 Workshop Session Continued

5:00 Social Hour
6:00 Adjourn

TUESDAY, APRIL 8, 1986

A.M.

8:30 From Overlay to CAD—Techniques for Inte-
grating Overlay and Photodrafting with CAD
* Overview of Present Applications for Manual

Overlay and Photographic Techniques with CAD
» Set up for Overlay
» Screening Techniques
¢ Drawing Production Methods—Manual/CAD
» Photographic
» Non-Photographic
» Photo Plotting and Other Photographic
Techniques
* Preparation for CAD
» Tools and Procedures
» Changes Required
¢ Project Management Procedures
» Sequence of Decisions
¢ In-House
e Client
¢ With the Advent of Computer Should a Firm
Consider Using Overlay and Photographic
Techniques?
» A Natural Stepping Stone
» Cost Effective Applications
e Comparison of Effectiveness in Relationship to
Computer-Aided Techniques
» Where is Overlay System Effectiveness Equiva-
lent to Computer-Aided Drafting?
» Labor, Time and Cost Comparison of Manual
and Automated Techniques
* How Can Overlay Drafting be Combined with
Computer-Aided Production?
» Why Combine Techniques?
» What Applications are Cost Effective?
* Current Applications of Computer-Aided Drafting
» Types of Projects
» Equipment Utilization
¢ Design Potential with CAD Systems
» Design Development
» Programming and Schematics
» Space Planning and Management
» Drawing Production
» Sales and Interactive Graphics
¢ Financial Impacts
» Equipment Costs
» Training Costs
» Environmental Costs
* Productivity Measurement Techniques
Examples and Case Studies

5

10:00
10:30

12:00

2:40
3:00

5:00

8:30

Coffee and Conversation

From Overlay to CAD—Session Continued
LUNCH

P.M.

Standardizing a Systematic Approach to
Working Drawing and Detail Development
e Steps and Procedures Leading to a
Standardization Program
» Office Organization
» Development and Use of Overlay and
Registration Drafting
» Photodrafting
» Scissors Drafting
> Keynoting
» Drafting Manuals
» Quality Control Standards
* What is a Standardization Program?
* Why Standardize?
» Increase Profits
» Allows More Time for Design Phase
» Prepares Firm for Computer Aided Drafting
» Provides a Reference File for Inexperienced
Employees
> Helps Prevent Negative Feedback
> Reduces Legal Problems
¢ What Should be Standardized?
» General Details
> Wall Section Components
» Floor Plan Components
> Notations, Legends and Symbols

Refreshments

Lecture and Workshop on Standardizing and
Systematizing Working Drawing Production
* The Standardization Program

> Methods for Development of Standards

» Numbering Systems

» File and Retrieval Systems

» Applying the Standards
e How a Firm can Achieve Standardization

» Establishing Priorities

» Task Force

» Production Coordinator

» Technical Resource Center

Adjourn

WEDNESDAY, APRIL 9, 1986

A.M.

Photographic Techniques Used in Production
Systems

» Photo Reproduction

» Why Have In-House Photo Reproduction?

6 OPEN




GENERAL INFORMATION

A Certificate of Participation is presented to each registrant. PRO-
CEEDINGS ARE NOT PUBLISHED.

ENROLLMENT: Advance registration required. Enroliment will be limit-
ed. Be sure you have a confirmed enroliment by mail or phone. FEE
covers cost of instruction, handout materials, noon lunches, one
evening dinner and break refreshments. Lodging and other meals
NOT included.

VETERANS: You may be eligible for fee reimbursement through an
educational grant from the Department of Veteran Affairs. Check with your
state regulations on educational assistance and with your County Vet-
erans Service Office of the county in which you reside for further informa-
tion. Contact your local county Veterans Service Office before you com-
plete the course.

REFUND: Your fee will be refunded if program is cancelled. If YOU can-
cel, you must notify us before program start date to receive refund.

MADISON, WISCONSIN PROGRAM, APRIL 7-11, 1986

LOCATION: Program held in the Wisconsin Center—northeast corner of
campus at Langdon and Lake Streets.

LODGING: A block of rooms have been reserved at the Wisconsin Center
Guest House at 610 Langdon Street, Madison Wisconsin, 53706, or
telephone (608) 256-2621. The Guest House features hotel-type service,
private bathrooms, color TV, pool and sauna, and parking upon request.
Low daily rates are $15.50 per person for a double room and $27.00 for
a single room (limited supply). Breakfast is served daily and can be
arranged for upon arrival. Information on various hotels and motor hotels
in the area and maps with campus details will also be sent to registrants.
PARKING: Extremely limited. Campus posted AREA restricted for per-
mit holders. Some permits (nominal daily fee) may be available. Metered
public parking in Lake Street Ramp and Helen White Hall (street level
opposite Wisconsin Union). Registrants will receive information.

PURGATORY/DURANGO, COLORADO PROGRAM—
AUGUST 18-22, 1986

LOCATION: Program will be held in the Village Center at Purgatory Village.
Durango is a quaint historic town born during the Rocky Mountain mining days
of the late 1800’s. Less than 25 miles north of Durango is the Purgatory Ski
Resort community which is set in the beautiful San Juan mountains marked by
jagged and picturesque peaks. Many family recreation activities are close at
hand. Hiking, sightseeing, fishing, river rafting, jeep tours, and Purgatory’s
Alpine Slide and swimming are exciting activities you will want to experience.
One can also visit the ancient Indian Cliff Dwelling at Mesa Verde National Park
or ride the famous Narrow Gauge Railroad which runs from Durango to the pic-
turesque mining town of Silverton. Check with Purgatory Guest Services for
special family packages (303) 247-9001.

LODGING: A block of single, double and special condominiums have been
reserved at the Purgatory Village Center Condominiums. Conference rates have
been established at $50.00 for a single (kingbed, 1-2 people), $60.00 for a Studio
Condo (1-4 people), $75.00 for a double (one bedroom, 1-4 people), and $95.00
fora Condo (2 bedrooms, fireplace and balcony, 1-6 people). Special six-night
package: Stay six nights and get sixth night free. Other types of accommoda-
tions are available upon request. For reservations call (303) 247-9000 Ext. 177
or write Purgatory Property Management, P.O. Box 666, Durango, Colorado
81302. Identify the *“CAD Management Conference’’ when making reservations.
Make reservations early to ensure the place of your selection.
TRANSPORTATION: Air transportation: Durango’s La Plata County Airport is
served by 3 airlines: Aspen Airways, (800) 525-0256; Trans-Colorado Airlines-
in-state (800) 332-4907 and out of state (800) 525-1455; and American West Air-
lines, (800) 247-5692. Check for United/Aspen Airways package. Ground trans-
portation: Bus transportation is available to Purgatory Ski Resort. Call Durango
Lift, (303) 259-5438 or write Purgatory Guest Services, for information and
special arrangements. Please advise transportation service of your arrival
time. Car Rental: Car rentals can also be made through Purgatory Guest
Services Reservations, (303) 247-9000.

TECHNIQUES FOR |
WORKING DRAWIN(
APRIL 7-11, 1986-

» Development Cost Factors

» Advantages and Disadvantages

» Design and Marketing Techniques

» Enlargement and Reduction of Production
Elements

» Storage of Documents

> Restoration of Documents

» Use of Video Tapes

Workshop Exploring the Use of Photographic
Techniques
* Photographic Techniques—35 MM Camera as a
Drafting Tool
» When to Draw and When to Photograph
» Use of Photographs on Drawing
» Paste-up Drafting
* Press-on Materials
¢ Transparent Stick-Ons
* Opaque
* Methods of Lettering

10:30 Coffee and Conversation

11:00 Document Printing and Equipment Require-
ments for Effective Production Systems
* The Vacuum Frame and Diazo Copier as
Production Equipment
» Why have In-House Production?
» In-House Reproduction as a Revenue Source
» Advantages and Disadvantages of Vacuum
Frame
» Overlay and Composite Drafting with the
Vacuum Frame and Office Copier
» Selecting Reproducible Material
» The Print Room Manager
¢ In-House Printing and Ancillary Equipment
* Reproduction of Drawings for Bidding Purposes
» Color Offset versus Diazo Printing
» Laser Plotting of Offset Printed Drawings
» Establishing a Production and Print Budget
* Checking of Working Drawings
» Discussion

12:00 LUNCH

P.M.
1:00 How to Set Up a Microcomputer CAD & Project
Management System
* Microcomputers, What Are They, What Can They 2?
» Low Cost Computer and. Word Processigg~
Capabilities _ :
» What This Means to the Process of Desigp and -
to You and Your Staff- ]
» Computer Applications For the Design Firm




PRODUCTION

MADISON, WISCONSIN

¢ An Example of a Microcomputer Set Up and
Operation
» The Micro Components ‘‘on board’’ Memory,
the Floppy Disk Storage System, Loading and
Saving Information.
» Analyzing Your Microcomputer Needs
> Assets and Liabilities in Working with
Microcomputers
> How to Get Started Within Hours
* Research and Selection of Your Microcomputer
and Software
» Evaluating Your Software Need, CAD and Job
Cost Accounting
» Analyzing the Computer Hardware
» Establishing the Budget for Your Microsystem
» Creating a ‘‘Request for Proposal’’
> Selection, Negotiating Cost and the
Maintenance Agreement
* Planning the Design Firm for Microcad Operations
» The CAD Workstation
» Selection and Staff Training
> Interaction With Project Management
* Special Considerations, Communications, Fixtures
and Equipment
» Creating the Right Attitude Toward the
Computer
» Installing the Microcad and Job Cost
Accounting System

2:50 Refreshments

3:10 Working with CAD and Microcomputer Systems
—Session Continued

4:30 Adjourn

5:15 Dinner
The Wisconsin Center

6:30 Hands-on Evening Workshop Covering Organi-
zational and Production Techniques

9:00 Adjourn

THURSDAY, APRIL 10, 1986

A.M.

8:30 Production of Engineering Drawings—CAD and
Systems Drafting
* Production Effectiveness
»-What Type Projects Give High Production
- ~  Ratios? :
» What Type Projects Give Low Production
Ratios?

10:00

10:30

12:00

1:00

TEGRATING CAD AND SYSTEMS DRAFTING T

» What Type Drawings Give High Production
Ratios?
» What Type Drawings Give Low Production
Ratios?
Production of Electrical Drawings
» Lighting Layouts
> Power Layouts
» Specialty System Layouts
» Riser and One Line Drawings
» Large Scale Drawings
» Schedules
» Details
Production of Mechanical Drawings
» Ductwork
» Piping
» Control Diagrams
» Large Scale Drawings
» Schedules
» Details
* Production of Plumbing Drawings
» Piping
> Riser Diagrams
» Fire Protection
> Large Scale Drawings
» Schedules
» Details
e Examples and Applications

Coffee and Conversation

Production of Engineering Drawings—CAD and
Systems Draftings—Session Continued

Lunch

P.M.

Developing a System to Maximize Integrated

Production Techniques—The Project

Management Process

* Why Project Management, Job Cost Accounting

and Systems Drafting Come Before ‘‘CAD”’

» Microcomputers and the Project Manager

» Development of Project Budgets, and
Schedules

» Development of Contract Document
Organization Plan

» Structuring a Project Management Schedule

» Monitoring the Project Cost

> Project Profitability, Accountability and Legal
Considerations

Using a Microcomputer in the Project Production

Process

> Intergrading Overlay, Photodrafting with CAD

» Programming and Schematic Design

10




IMPROVE

» Design Development
» Schedules
» Keynotes for Drawing
» Outline and Finished Specifications
» Production of Engineering Drawings
» Scan/Digitized Inputting of Drawings and
Details
» Quality Control of Contract Documents
» System Networking and Expansion
¢ System Managing and Staff Development
» The Tasks of a CAD Manager
» Effective Management Techniques
» Staff Requirements
» Developing Training Manuals
» Creating Standards and a Data Base
» System Maintenance
> Measuring Your System’s Profitability

3:00 Refreshments

3:20 Reducing Liability Insurance Through a
Systems Approach
* Business Procedures
» The Design Professional as a Businessman
» The Project Cost
» The Firm’s Capabilities
* Technical Procedures
» The Importance of Having a Quality Assurance
Program
» Back to School
» Untried, Untested and Undesirable
» Drawing Symbol List, Legends and Notes
» Specifications
» Drawing Omissions
» Bid Period
» Shop Drawing Review
» Project Follow-up
* Intercommunications
» Contracts
» Scope of Services
» Contract Pitfalls
» Estimating
» Recruiting Practices
» Motivating Your Personnel
» Employee Performance Evaluations
» Eliminating the Fire Drill Approach

5:00 Adjourn

FRIDAY, APRIL 11, 1986
A.M.

8:30 Developing a Comprehensive Data Base
¢ Types of Information

11

10:00

10:30

12:00

1:00

3:30

» Details

» Schedules

» Design Data

» Specifications

» Checklists

» Cost Information

» Quantities
¢ Accessing Valuable Production Information
e Setting Standards for Working Drawing Production
* Successful Software Programs
» Effective Production Techniques
* Examples and Case Studies

Document Storage and Retrieval
* Changes to Drawings
¢ Record Drawings
¢ Storage Systems
» Microfilming
» Filing
» Costs

Coffee and Conversation

Quality Control of Design Development,
Working Drawings and Specifications
¢ Quality Control Director
¢ Establishing a Production Budget and Schedule
* Preplanning of Construction Document Production
¢ Project Coordination Meetings
¢ Document Phase Reviews

» Schematic

» Design Development

» Working Drawing
¢ Final Checking Process

» Establishing Procedures

LUNCH

P.M.

Production Aids Which Assist in Maintaining
Quality Control and Equipment Selection to
Improve Performance

* Project Management Manual

¢ Drafting Manual

e Standard Details

¢ Master Specifications

¢ Technical Resource Center

¢ Educating Staff

¢ Selecting Equipment to Improve Efficiency

¢ Future Directions-

13

Adjourn
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Mail to: Architectural Programs
THE WISCONSIN CENTER
702 Langdon Street
Madison, Wi 53706

WORKING DRAWING PRODUCTION AND CAD
MANAGEMENT PROGRAMS

Name _____ el T

Title/ Position

Company e A

Address ST

City and State Zip

Office Telephone Number ___

Social Security Number*

*““Not mandatory—used only to ensure identification, accessibility and accuracy of
your education ‘‘record.""

1. [J Techniques for Integrating CAD and Systems Drafting to Im-
prove Working Drawing Production
April 7-11, 1986 (5.0 CEU) Program No. 6045
Fee: $545.00

2. [] Effective Management of CAD Systems and Production
August 18-22, 1986 (5.0 CEU) Program No. 6046
Fee: $595.00

Register for any combination of programs you desire to attend. Please
enclose enroliment fee. Make checks payable to University of Wisconsin-
Extension.

This information is collected to enhance the programming efforts of University of Wis-
consin-Madison and is voluntary.

Sex: Female Male

Birthday: Month Day Year ______

Heritage: American Indian ___ Asian Black
Hispanic White or Other

Occupational Area:
100 Professional, technical and managerial occupations

700 Other occupations

Philip M. Bennett, Program Director

Department of Engineering Prof ] | Develop t
University of Wisconsin-Madison

432 North Lake Street

Madison, Wisconsin 53706

Telephone: (608) 262-1299 for program enroliment.
(608) 263-4705 for program information.

University of Wisconsin-Extension provides equal opportunity
in programming and employment.

This program meets criteria for the nationally
—— accepted Continuing Education Unit. It carries
the indicated CEU value for each participant
completing it successfully and it is applicable
for credit toward the University of Wisconsin
— Professional Development Degree in Engineering.
Ask for degree details and qualifications.
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EMENT OF CAD SYSTEMS AND PRODUCTION

)86 — PURGATORY/DURANGO,COLORADO

PURPOSE
A new role in the workplace is quickly emerging with the devel-
opment of computer technology. As more and more organizations
bring on computer systems, the need for organization and con-
trol is growing. For many firms, the computer has helped speed
up and increase their workflow and as a result created a need for
the “system manager.” This new responsibility is growing rap-
idly as more organizations move to automation.

Most individuals accepting the challenge of this new role are learn-
ing the “management system” through an experiential
process. Since little is written on this new field, it is difficult for
the newcomer to gain needed training except through hands-on
experience. This method can be both costly and time consum-
ing and leaves many decisions to chance. Our new workshop has
been developed for the “present” and “future” CAD manager
to increase the knowledge base necessary for effective decision
making and creative management.

OBJECTIVES

¢ Provide the Opportunity to Explore Workable Manage-
ment Techniques.

e Learn From the Experiences of Other Managers.

¢ Develop Guidelines and Procedures for Creative Prob-
lem Solving.

¢ Exchange Ideas and Information Generated in the Com-
puter Field.

e Explore New Concepts in Managing Technology
Changes and Human Performance.

INSTRUCTORS

JONATHAN HOGAN, President, Jonathan Hogan & Associates
Specializing in CAD Consulting to the Construction Industry;
Former General Manager, UDC International; In charge of a
50-person office utilizing multivendor computer systems to serve
the construction industry, exploration, utilities and municipal
governments; Founder of two university computer departments;
Former faculty member at the University of Houston; Specialized
experience in computer installation, maintenance, scheduling,
security and system operation; Member of the Houston Chapter
AIA Computer Subcommittee; San Diego, California.

DAVID A. JORDANI, AIA, President, David A. Jordani & Asso-
ciates, Consulting Services in management and selection of com-
puter systems; Former manager, Interactive Graphics Systems,
Ellerbe Associates, Inc., Architects-Engineers; A registered archi-
tect with several years of professional experience in the applica-
tion of computer technology to the design profession; 5 years of
manager experience for large A/E firm with responsibility for plan-
ning, direction and implementation of computer-aided design;
Consultant in selection, management and implementation of
CADD systems; Author and lecturer on computer applications in
architecture and engineering; Chairman of AIA’s Committee on
Computers in Architecture; Trustee for APEC; Former faculty
member with Department of Architecture, University of lllinois;
Member of IGES/AEC subcommittee on data exchange; Minne-
apolis, Minnesota.

15

PROGRAM DIRECTOR AND MODERATOR

PHILIP M. BENNETT, Architect; Program Director, Department
of Engineering Professional Development, University of Wiscon-
sin-Madison, Madison, Wisconsin.

PRESENTATION FORMAT

¢ A Combination of Lectures, Workshops, and Group Discussion
Sessions Will be Used to Communicate Effective Management
Techniques.

e Common Management Problems Will be Analyzed to Demon-
strate Successful Solutions.

* Software Applications Will be Identified and Explored for Par-
ticipant Use.

PROGRAM 2

MONDAY, AUGUST 18, 1986

A.M.

8:00 Registration
Purgatory Day Lodge at the Purgatory Village Center
Condominiums

8:30 Welcome and Introduction
Philip M. Bennett
Program Director

8:45 Session 1—Developing a Management Plan
* Developing an Overall Corporate Philosophy and
Direction Regarding Automation
» Corporate Commitment
¢ Structuring the Management Plan Suitable for Produc-
tion Requirements
» Organizational Needs
* Production Systems in Use
* Size and Type of Organization
» Service/Project Types
e Goals and Future Growth Projections
* Workload and Workflow Requirements
» Organization of CAD Group Within Firm
» Workflow Patterns
» Client Demands
» Scheduling Production
e Characteristics of Different Production Disciplines
» Architectural
» Engineering
» Interior Design
» Space Management
» Office Automation
» Others
10:00 Coffee and Conversation

10:30 Session 1—Developing a Management Plan—
Session Continued

16



12:30

1:30

3:00

3:20

5:00
6:00

Lunch

Session 2—Project Planning, Selection and

Management

* Project Production Criteria

¢ Analysis of Project Production Requirements

* Selecting and Ranking Projects for CAD production
» Critical Factors

¢ Developing a Project Document Mockup

¢ Scheduling Elements of the Project for Appropriate e
Production Methods

* Structuring a Project Management Schedule

* Monitoring Project Development Process 1:30

Refreshments

Session 2—Project Planning, Selection and
Management—Session continued

Social Hour

Adjourn

TUESDAY, AUGUST 19, 1986

8:30

10:15
10:45

A.M.

Session 3—System Management Requirements
and Resources
¢ Understanding the Inherent Characteristics of Each
CAD System
» Production Capabilities
» Operational Requirements
» System Limitations
* Maximizing System Use
» Understanding its Functions
» Taking Advantage of System

» Selecting Appropriate Production Areas for Each e
System 3:30

» Designing Production Program Based on System’s 1
Qualities

* Measuring System Performance

Coffee and Conversation

Session 4—Standards and Application
Development

¢ Developing Procedures and Methods of Production
¢ Selecting and Developing Standards

» Symbols » Details
» Layers » Schedules
» Pen Weights » Notation

» File Names
¢ Establishing Application Techniques and Models
» Implementation Procedures
» Time-Saving Techniques
» Short-cuts

17

* Developing Office Procedures and Applications
Manual
* Creating Special Symbol Libraries
» Architecture
» Engineering
» Interior Design
» Space Management
» Construction
¢ Flexibility in Application of Standards

Lunch

Session 5—System Maintenance, Security and
Performance
* Hardware Maintenance
» Preventive Maintenance
» Malfunctions
¢ Software Maintenance
» System Upgrades
» Isolating Problems
¢ Documenting Problems
* Maintenance Contract
» Reporting Procedures and Responses
¢ Dealing with Down Time and Maintenance
» Structuring Alternative Production Systems
» Scheduling Maintenance Activities
¢ Vendor Maintenance Versus 3rd Party Maintenance
¢ External and Internal Security Measures
» Security Versus Isolation
» Back-up Systems that Work—Frequency
» Disaster Protection
» On-Site Versus Off-Site Protection
¢ Tuning Parameters and Requirements
» System Generation
» User Configuration

Refreshments

Session 6—Budgets, Profitability, Accounta-
bility and Legal Considerations
¢ Structuring Production Budgets
» Equipment
» Staff
¢ Charging for Services
» Billing
» In-House Service
Contractual Relationships
» Fixed Fee
» Multiple of Labor
Profitability in Application of CAD
» Areas of Cost Benefits
» Labor and Cost Savings
Cost Analysis Based on System Utilization
» Evaluation of System Operation
» Cost Effective Activities
» Problem Areas

18 OVER
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EFFECTIVE MANA
AUGUST 18-22, 1

> What are the Real Benefits
¢ Legal Implications
» Consultant Relationships
» Insurance Requirements

5:00 Adjourn

WEDNESDAY, AUGUST 20, 1986

8:30 Session 6—Budgets, Profitability, Accounta-
bility and Legal Considerations—Session
Continued

10:00 Coffee and Conversation

10:30 Session 7—System Networking and Expansion
* Networking Systems
» Effective Linkages
e Exchanging Graphics Data Bases
» Drawings
» Product Data
» Archival Data
» Non-Graphic Linked Data Bases
¢ File Formats for Communication
e System Expansion Potential
¢ Planning for Growth
» Acquisition Schedule
¢ Reasons for Expansion
» Success
» Client Driven
* Expansion Options

12:00 Lunch

1:00 Session 7—System Networking and Expansion
—Session Continued

2:30 Refreshments

2:50 Session 8—Software Development Exchange

Workshop

¢ Software Availability and Use

e Exchange of Effective Software Applications

* Software Development—In-House Versus 3rd Party

* Advantages and Disadvantages of Writing Your Own
Software

* Legal Implications of Marketing Your Own Software

* Software Contracts

e What is the Future of CAD Programs

¢ Special Interest Groups

* User Group Discussions

5:00 Adjourn

EFFECTIVE MANAGEMENT OF CAD
PURGATORY/DURANGO, COLORADO

IMPROVE WORKING DRAWING
23YSTEMS AND PRODUCTION

" PRODUCTION
APRIL 7-11, 1986
MADISON, WISCONSIN
AUGUST 18-22, 1986

THURSDAY, AUGUST 21, 1986
A.M.

1 CAD AND SYSTEMS DRAFTING TO

-
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86—PURGATORY/DURANGO, COLORADO

8:30 Session 9—Managing and Training Production
Personnel
* Where Should the Production Take Place?
» Centralized Versus Distributed
» Interdepartmental Communications
* Internal Staff Organization
» Job Descriptions » Staff Selection
» Career Ladder
* Staff Requirements for Production
» Number of Stations
» Production Demands
» Turn Around Time
* Determining Production Hours
» Scheduling Work Shifts
» Manager Coordination
» Establishing Production/Relaxation Periods
* Managing Personnel for Support of System
» Programmers
> Hours, Responsibilities, Education, Experiences
and Salaries

¢ Dealing With Physiological and Psychological Factors

> Fatigue > Stress
> Boredom > Shift Work and Fast Production
* Developing Work Incentives Program
> Benefits
» Work Patterns
» Teamwork
» Tracking and Performance Measurement
» Compensation
> Bonuses
* Training for Effective Operation of System
» Staff Requirements
» Training Needs
» Advancement
* Developing a Training Plan
» Scheduling Staff
» In-House Versus Vendor Training
* Project Team Training
» Techniques
» Benefits
* Developing Training Manuals
* Dealing with Personnel Problems
> Methods
> Examples
> CAD-Related Issues

10:00 Coffee and Conversation

10:30 Session 9—Managing and Training Production
Personnel—Session Continued

12:00 Lunch

P.M.

1:00 Session 9—Managing and Training Production
Personnel—Session Continued

3:00 Refreshments

20

3:20 Developing an Effective Management Plan for
Your Organization
* A Special Workshop to Structure a Management Pro-
gram for Specific Organizational Needs
» Exploring the Key Issues
* Developing Critical Steps to the Management Program
* Evaluating Your Management Plan
* Individual and Team Interaction Sessions

4:30 Adjourn

FRIDAY, AUGUST 22, 1986
A.M.

8:30 Developing an Effective Management Plan for
Your Organization—Workshop Session
Continued

9:45 Coffee and Conversation

10:15 Session 10—Creating the Proper Work
Environment
* Planning the Physical Environment
» Critical Issues
> Problem Areas
¢ Workstation Design
» Equipment Relationships
» Screening and Isolation Requirements
> Task Analysis and Physiological Requirements
» Space Requirements
* Location of Equipment for Most Effective Production
» In Drafting and Production Area
> Separated from Related Activity Areas
> Linked to Other Systems
* Developing the Proper Physical Environment
> Lighting— Glare, Reflections
» Acoustics
> Air Conditioning
» Static Conditions
* Electrical Requirements
» Back-Up Systems
> Voltage Controls
> Load Balancing
* Effect of Computer Workstation Relationships on the
Management Plan
» Visual Control
> Personnel Interaction
» Security Considerations
* Who Should Have Access to System Services?
» Criteria for Use

12:00 Lunch

1:00 Session 10—Creating the Proper Work
Environment—Session Continued

3:00 ' Adjournment
21




OPNAV 5216/144A (Rev. §-81) OL,(/\T: DEPARTMENT OF THE NAVY
S/N 0107-LF-052-2320 3
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: ol Memorandum

DATE: 25 Aug 86 ffb~h£ﬁ; = ?SLi- kl*hélQﬁL :

frRom: Civilian Personnel Officer, Marine Corps Base, Camp Lejeune

TO: Distribution List

SUBJ: FY87 CIVILIAN TRAINING
Ref: (a) CG MCB CLNC 1ltr 12410 CPD 10 Dec 85

Encl: (1) Subject listing
(2) Civilian Employee Training Request Form

1. Enclosure (1) identifies funded training for FY87 as approved
by the Commanding General.

2. The Civilian Training Office will implement funded training

for the individuals named on the Civilian Employee Training Request
forms submitted during the Civilian Training Requirements Survey
announced by the reference. It is realized that changes in personnel
and/or courses may be required due to nonavailability of quotas,
changes in personnel assignments, and other changes in priorities.
Substitutions will be considered. A new Civilian Training Request
Form, provided as enclosure (2), must be submitted for any substi-
tutions.

3. Please forward to the Civilian Personnel Division (Training
Branch) any individual course brochures, announcements and/or

company application forms when receivez.
lo A HORNﬂ(

Distribution:

AC/S, COMP

AC/S, MANP

AC/S, LOG

Dix . RASEC

CO, MCSSS

CPD

BHD

DFH

DISB

FSC

FIRE

MAIN

NREA
MO

SAFD

SSVCS

%rU.S. GOVERNMENT PRINTING OFFICE: 1985 — 506-012/18049






v FY 1987 CIVILIAN TRAINING

~ Public Works
v .INDIRECT DIRECT

COURSE TITLE AND LOCATION COST COST TOTAL

Funded

Techniques for Integrating CAD l<

and Systems Drafting to Improve

Working Drawing Prod.

Madison, WI $ 870.00 $ 545,00 $ 1415.00
o

A/C Design - Piping Systems \

Madison, WI @s P 870.00 790.00 1660.00

. : W\ b

Environmental Protection \§ Q.0

CECOS East 4 Q 388 .00 = 388 .00

A/C Design LQ“?“Vﬁ;

Madison, WI ' <& 720.00 790.00 1510.00

NFCTC Design Contract Management

LANTNAVFACENGCOM 56\\%«6‘?”— 380.00 - 380.00
Total $ 3228-.08@ $ 2125.00 $ 5363.00

Unfunded

National Electrical Code "y

Raleigh, NC A $ 346.00 $ 420.00 $ 766.00

Microcomputer_4§hl“ﬂ

Clemson, S.C. “&¢° 530.00 450.00 980.00

Coordination

(%)
Dallas, TX ’<°Yo\°’( 795 .00 900.00 1695.00
‘D

Environmental Protection

CECOS East 400.00 ; - 400.00

How to Interpret and Apply the

1986 Life Safety Code R

Charleston, S.C. ‘5ﬂmz;§ﬁr\ 50 1 s Qritnao i G- o G100
Total $ 2572.00 $ 2265.00 $ 4837.00

- . iwlE A + YiATx o
"

ENGLOSURE (/)

et e







2
L N @(LIAN"EMPLOYEE TRAINING REQUES'&?

Employee Name Grade Organization

Course Title

Length of Course Location

Employees Last Official Performance Rating

COST: Registration $ Per Diem $ Travel $ Total §

1. Priority assigned to the training requirement.

/ / PRIORITY ONE - ESSENTIAL: Training required during FY 1985 that is considered
essential to mission accomplishment for one or more of the following reasons:

-

/ Training Needed to ensure attainment of performance objectives

Training needed to correct serious performance deficiencies

1

/ Training required by law, regulation,*or higher authority

-

7 / Training required for operation/maintenance of new equipment

. T] Training required for employees enrolled in a recognized formal
training program
/ / PRIORITY TWO - NEEDED: Training which if not funded may impact adversely
on complete and qualitative mission accomplishment during the next two to
three fiscal years. Example: Training to provide for the systematic
replacement of skilled employeces.

/ / PRIORITY THREE - USEFUL: Training of a broadening nature that might be
helpful in enhancing the overall performance levels of employees already
considered to be competent.

2. Provide more specifically why this training is being requested.

3. How many of your employees have already received this or similar training?
4. What will be the impact on the organization or employee if this training is
not received? :

5. Certification of training requirement:

I certify that I have reviewed the training requested for this employee. It is
my opinion that the training is necessary to support the mission of the organization
and the command; and that the priority assigned meets the criteria established.

Immediate Supervisor 2d Level Supervisor

EbiCL(BURE- (2) ‘

Sl PR
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EL 5 @ILIAN"EMPLOYEE TRAINING REQUES.Ib

Employee Name _ William Matthew Woodward  grage GS-5 OrganizationPublic Works
Course Title National Electrical Code DATES OF COURSE: Mar 2-4, 1987
Length of Course 3 days Location Raleigh, North Carolina

Employees Last Official Performance Rating

COST: Registration $ 420 per Diem § 296 Travel § °0.02 Total § 766.02

1. Priority assigned to the training requirement.

/X /] PRIORITY ONE - ESSENTIAL: Training required during FY 1985 that is considered
essential to mission accomplishment for one or more of the following reasons:

/ / Training Needed to ensure attainment of performance objectives
[ / Training needed to correct serious performance deficiencies

/ / Training required by law, regulation,-or higher authority

L / Training required for operation/maintenance of new equipment
X

Training required for employees enrolled in a recognized formal
training program

/ / PRIORITY TWO - NEEDED: Training which if not funded may impact adversely
on complete and qualitative mission accomplishment during the next two to
three fiscal years. Example: Training to provide for the systematic
replacement of skilled employeces.

/ / PRIORITY THREE - USEFUL: Training of a broadening nature that might be

helpful in enhanézhg the overall performance levels of employees already
considered to be competent.

2. Provide more specifically why this training is being requested.

The course teaches the application of National Electrical Code for engineering designs.

3. How many of your employees have already received this or similar training? one

4. What will be the impact on the organization or ¢

mployee if this training is
not received?

Engineering designs may be in non-compliance with the National Electrical Code.
5. Certification of training requirement:

I certify that I have reviewed the training requested for this employee. It is
my opinion that the training is necessary to support the mission of the organization
and the command; and that the priority assigned meets the criteria established.

A. E. YOUNG F. E. CONE, DESIGN DIRECTOR
Immediate Supervisor 2d Level Supervisor

T. L. HUGUELET, PWO
-~ ..Department Head .. . - - . : :
v la s e g il ENCLOSURE (2)
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p, @ILIAN"EMPLOYEE TRAINING REQUES N

Employee Name William Matthew Woodward Grade GS-5 Organization Public Works
Course Title MicroComputer DATES OF COURSE: Aug 3-5, 1987
Length of Course 3 days Location Clemson, South Carolina

Employees Last Official Performance Rating

COST: Registration $ 450.0Per Diem $§ 272 Travel $ 258 Total $ 980.00

1. Priority assigned to the training requirement.

/X ] PRIORITY ONE - ESSENTIAL: Training required during FY 1985 that is considered
essential to mission accomplishment for one or more of the following reasons:

e
~

Training Needed to ensure attainment of performance objectives

Training needed to correct serious performance deficiencies

101

Training required by law, regulation,- or higher authority

l\

Training required for operation/maintenance of new equipment

1k

S~

Training required for employees enrolled in a recognized formal
training program Training available at Camp Lejeune is directed toward
___clerical use of microcomputers. Training requested is directed at the uses of the

/ / PRIORITY TWO - NEEDED: Training which if not funded may impact adversely micro-
on complete and qualitative mission accomplishment during the next two to computer
three fiscal years. Example: Training to provide for the systematic 1in the
replacement of skilled employces. Engineering |

field.

/ / PRIORITY THREE - USEFUL: Training of a broadening nature that might be

helpful in enhancing the overall performance levels of employees already

considered to be competent.

2. Provide more specifically why this training is being requested.

To develop working knowledge of microcomputers and interfacing of peripherals.

3. How many of your employees have already received this or similar training?
4. What will be the impact on the organization or employee if this training is

not received? ; : . 4
Engineering Designs may be inadequate

and costly.

5. Certification of training requirement:

I certify that I have reviewed the training requested for this employee. It 1is
my opinion that the training is necessary to support the mission of the organization
and the command; and that the priority assigned meets the criteria established.

-

A. E. YOUNG F. E. CONE, Design Director
Immediate Supervisor 2d Level Supervisor
~ T. L. HUGUELET, PWO.
e - . Department Head . =~ -

EﬁCLOSURE (2)
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TN @ILIAN‘H\IPLOYEE TRAINING REQUES/ N

William Matthew Woodward GS-5

Employee Name

Grade Organization

Public Works

Course Title Coordinatlo? DATES OF COURSE: Jan 5-9, 1987

Length of Course 5 daye Location Dallas, Texas

Employees Last Official Performance Rating

COST: Registration § 900 Per Diem $ 450 Travel § 344

1. Priority assigned to the training requirement.

/X ] PRIORITY ONE - ESSENTIAL: Training required during FY 1985 that is considered
essential to mission accomplishment for one or more of the following reasons:

S
~

Training needed to correct serious performance

il

/ / Training required by law, regulation,* or higher
/ / Training required for operation/maintenance of
L3

training program
& / PRIORITY TWO - NEEDED: Training which if not funded ma
on complete and qualitative mission accomplishment dur
three fiscal years. Example: Training to provide for
replacement of skilled employces.

/ / PRIORITY THREE - USEFUL: Training of a broadening nat

helpful in enhancing the overall performance levels of
considered to be competent,

Total § 1,694

Training Needed to ensure attainment of performance objectives

deficiencies

authority

new equipment

Training required for employees enrolled in a recognized formal

y impact adversely
ing the next two to
the systematic

ure that might be
employees already

2. Provide more specifically why this training is being requested.

The course provides insight into short-circuit analysis and the application of

protective devices in electrical circuits.

.

What will be the impact on
not received?

How many of your employees have already received this or similar training?

the organization or employee if this training is

Inefficient and costly engineering designs may result.

5. Certification of training requirement:

I certify that I have reviewed the training requested for this employee. It is

my opinion that the training is necessary to support the mission of the organization

and the command; and that the priority assigned meets the criteria established.

A. E. YOUNG F. E. CONE,

Design Director

Immediate Supervisor

T. L. HUGUELET, PWO .
. Department Head .. . -

2d Level Supervisor

ENCLOSURE (2)







COST:

Employee Name Grade Organization

Registration § Per Diem §$ Travel § Total §$

&3
@ILIAN‘EI‘IPLOYEE TRAINING REQUES"\V’

Course Title

Length of Course Location

Employees Last Official Performance Rating

1. Priority assigned to the training requirement.

/ / PRIORITY ONE - ESSENTIAL: Training required during FY 1985 that is considered
essential to mission accomplishment for one or more of the following reasons:

S~
~

Training Needed to ensure attainment of performance objectives

Training needed to correct serious performance deficiencies

1

T4 / Training required by law, regulation,'or higher authority
/ / Training required for operation/maintenance of new equipment
/ / Training required for employees enrolled in a recognized formal

training program

/ / PRIORITY TWO - NEEDED: Training which if not funded may impact adversely

on complete and qualitative mission accomplishment during the next two to
three fiscal years. Example: Training to provide for the systematic
replacement of skilled employces.

PRIORITY THREE - USEFUL: Training of a broadening nature that might be

helpful in enhancing the overall performance levels of employees already
considered to be competent,

2. Provide more specifically why this training is being requested.

-

3. How many of your employees have already received this or similar training?

4. What will be the impact on the organization or er

3

iployee if this training is

not received?

5. Certification of training requirement:

I certify that I have reviewed the training requested for this employee. It is

my opinion that the training is necessary to support the mission of the organization

and the command; and that the priority assigned meets the criteria established.

Immediate Supervisor 2d Level Supervisor

':,,,,Depa:t!en;-nead“.}; 5

MURE (2)







14 April 1986
Public Works Officer, Marine Corps Base, Camp Lejeune

Bdvilian Personnel Division (Attm: Training Branch)
Via: Assistant Chief of Staff, Facilities

CIVILIAN TRAINING REQUIREMENTS, FY 1987
Ref: (a) CC MCB CLNC memo of 12 Mar 1986 w/Fac memo 12410 FAC of 14 Mar 1986
Encl: (1) Civilian Employees' Training Request Forms

1. The enclosure has been reviewed as requested by the reference and is
resubmitted.

M. I.. KIMBALL







OPNAV 5216/144A (Rev.8-81)
S/N (107-LF-052-2320

-

DATE:

FROM:

TO:

Via:

SUBJ:

Ref:

Encl:

26 Feb 1986

Public Works Officer, Marine Corps Base, Camp Lejeune

Civilian Personnel Division (Attn: Training Brangh)
Assistant Chief of Staff, Facilities.‘1g§7¢éﬁéu/§1\ E?/é?/%’é

CIVILIAN TRAINING REQUIREMENTS, FY 1987

(a) CG MCB CLNC ltr of 10 Dec 1985

(1) Civilian Employees' Training Request Forms

13

In response to the reference, the enclosure is forwarded.

M. I. KIMBALL
By direction

DEPARTMENT OF THE NAVY

Memorandum
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‘ g DEPARTMENT OF THE NAVY /ﬂr
OPNAYV 5216/144A (Rev. 8-81)

ot Memorandum

[

12410 ﬂH
"MAR 14 1986 FAC

FROM: aAssistant Chief of Staff, Facilities, Marine Corps Base,

Camp Lejeune V "
To: DISTRIBUTION : - fle??

SUBJS: CIVILIAN TRAINING REQUIREMENTS, FY-1987
Encl: (1) CG MCB memo dtd 12 Mar 86

1. The enclosure is forwarded for compliance as requested.
Provide response via this office.

B. W. ELSTON
By direction

DISTRIBUTION:
E >PWO

DBH

DFH

",

4 11. 9. COVERNMENT PRINTING OFFICE: 1982-505-106:8483






1444 (Rev. 8-81) DEPARTMENT OF THE NAVY

)
- S/N_0107-LF-052-2320

DATE:

FROM:

TO:

SuUBJ:

Ref:

Encl:

E Memorandum

“ 22 MAR 1565 ' :
Commanding General, Marine Corps Base, Camp Lejeune

Distribution List

CIVILIAN TRAINING REQUIREMENTS, FY 1987
(a) Enclosure 2, BO 12410.3H

(1) FY87 Civilian Training Requirements
(2) Training Priorities and Resources

1. We are returning your submission of FY87 Civilian Training
Requirements as enclosure (1) and requesting that a closer review
be made. It is very important that priorities be properly assigned
each training request. Priorities should be assigned using the
Navy's criteria as defined in the reference. These definitions are
forwarded as enclosure (2) for easy access.

2. Additionally, written justifications should support the assigned
priorities. When Priority I's are assigned, a strong justification
is needed. 3

3. When training is required by law, regulation or higher authority,
cite the regulation requiring it. Please note that the training
itself must be required, not the Performance of the duties for

which trained. =

4, Training required for operation/maintenance of new equipment
is Priority I only when, without the training, the equipment
cannot be used at all or to a very limited extent.

5. -The only recognized formal training programs are those for
which there is an entry grade level and a higher target grade
level. Training requirements for these trainees are submitted
by the Civilian Training Office.

6. When appropriate, reassign the priorities on your requirements
and return them to the Civilian Personnel Division, Training Branch
bygéswApr1L4F9&6. Tf you have additional questions please call

Mrs. Linda Passingham, extension 1539.

Js

By/Airection

Distribution:

-AC/S, FAC

AC/S, MANP
AC/S, MWR
Dir, RASC
CO, MCSSS

“ae
ar






. ' BO 12410.3H

22 Dec 1983

. TRAINING PRIORITIES AND RESOURCES

1 Priorities. The following priorities will be observed in identifying training
needs and 1n preparing Annual Training Plans in accordance with DOD Instruction 1430.5:

a. Priority I - Training which must be accomplished in the ensuing annual train-
ing cycle to avert a direct adverse effect on mission accomplishment. Also, training
which is required by law or regulation. Examples of Priority I type training are:

(1) Training in the operation and/or maintenance of new equipment, without
which the equipment could not be placed in service and a critical function could not be
performed.

(2) Upward mobility training as required by law.

(3) Training for new first-level supervisors as required by the Office of
Personnel Management and Department of the Navy regulations.

(4) Training of employees in formal career management programs and formal
trade-craft training programs as a prerequisite to their advancement under career
promotion regulations.

(%) Training required to comply with a nepgotiated labor management apreement.

(6) Training for new Equal Employment Opportunity counselors as required by
Department of the lavy regulations.

b.:- Priopity - I1 - Training which i= required to provide for systematic replacement
of skilled employees through development -programs and if deferred beyond the ensuing
training cycle would have an adverse effect on mission accomplishment in the period
following. Examples of Priority II Type training are:

(1) -Skills update training.

(2) Management and supervisory development training.
==
¢. Priority III - Training which 4s required for an employee who 1is performing at
an adequate level of competence, but will increase individual efficlency and productiv-
ity and may be accomplished after Priority I and Priority II needs have been met. No
examples of training which meet this Priority need be described. However, the delivery
of Priority III training need not be delayed until after all other training has been
completed; rather, resources must be allocated in the order of training priorities.

2% Sources of Training. Generally, in identifying sources for obtaining training,
the order of consideration will be: local, agency, intra-agency (DOD), interagency and
nongovernment. Capabdility of sources to provide training needed and overall costs will
obviously influence final selections.

a. Training and Development through Correspondence Study. The military depart-
ments offer a wide variety of courses through thelr correspondence course centers.
Some formal school courses are also available through correspondence study. There 1s
no cost for correspondence courses except those offered by the Office of Personnel
Management. Course catalogs are maintained by and are available at the Civilian
Personnel Division, Training Branch.

b. Civilian Personnel Division. The Civilian Personnel Division routinely
provides or sponsors training in civilian personnel administration. This includes new
employee orientation, training for new first-line supervisors, preretirement planning
training, and personnel management for supervisors covering such topics as discipline,
leave, labor-relations, classification, and performance ratings. Based upon annual
training needs surveys the Civilian Personnel Division also hosts other training
through agency, interagency or nongovernment resources when it is more economical to
conduct the training locally.

ENCLOSURE (2)







OPNAV 5216.144A (Rev.8-81)
$/N 0107-LF-052-2320

DATE:

FROM:

T0:
Via:

SUBJ:

Ref:

Encl:

DEPARTMENT OF THE NAVY

Memorandum

14 April 1986
Public Works Officer, Marine Corps Base, Camp Lejeune

Civilian Personnel Division (Attn: Training Branch)

Assistant Chief of Staff, Facilities

CIVILIAN TRAINING REQUIREMENTS, FY 1987
(a) CG MCB CLNC memo of 12 Mar 1986 w/Fac memo 12410 FAC of 14 Mar 1986
(1) Civilian Employees' Training Request Forms

1. The enclosure has been reviewed as requested by the reference and is
resubmitted.

M. I, KIMBALL

Ty






Civilian Ingloyee Tradining Fogoest @

e kEEblO)‘(’C Name WEISSENBERGER, Thomas Grade GS-4 Orgcniz‘é(ion Public Works
. Techniques for Integrating CAD & Systems % -
‘Course Title Drafting to improve Working Drawing Prod.DATES OF COURSE: - -

The College of Engineering

Length of Course 5 Days Location  ypjversity of Wisconsin, Madison. Wisconsin _

Ezployees Last Official Performance Rating Satisfactory

COST: Registration § 545.00 Per Diem $487.50  Travel §382.00 Total § 1,414.50
1. Priority assigned to the training requirecent.

LX 7 PRIOR1T¥70NE_'.EESEHII@L: Training required during:FY 1§§Z‘that is-considered
essential t6 mission accomplishment for one or more of the following reasons:

Training needed to correct serious performance deficiencies

Trzining required by law, regulation, or higher zuthority

/ x Treiuing required for operztion/rzintenznce of new eculpment
q 4 Julp
T

Ireining required for c—ployees enrolled in 2 tecegnized forrel
* trzinding progrem

[ @ PRIOPITY 10 - KEELEEE MRetntng vhich 1f nbt funded vay frpzect clvercely
cn ccmplete cnd quelitztive riceion zccozplish-ent Cduring the ncxit &0 to
three ficcel yeczre. E:czples Trzinfng to provide for the syctc-rtic
repizcezent of ehiilled e=ployees. ; 3

L__::? PPICRITY TrREE - USEFUL: Trzining of 2 brozéening nzture thet right be
helzfvl 4a ohzneing the overzll perforccnce levels of c=ployeces clzccdy

ccaeidered to be cernetent,

\

|

- - . 2 e \

2. Trevide —ore cpecificzlly sshy this treining is being requested.
To advance in-house programs utilizing the CAD Systems approach to production

of working drawing. |

|

|

3. How z=zny of your ecployees heve zlrecdy received this or similer trzining? 0
4. ket vill be the Irpzst on the orgznizstion or enployee 1f this trzining 4

not recelved?
Inability to utilize CAD Systems approach to in-house production of
working drawings necessary for increased levels of contract completions.

5, Coemvigfertion-of tFai®ing werulfe -2t
.
I cengilfy thzt, I hondssaibamatsthe trsining @oguecrted fopehte (o~ Yeves “ Tr¥ iy
e 4 L - T . - PR - d . P - = -~ - - -
=y ¢pfnfen thet the training Zs nicczzery to rupyort the mleefen of the FETirLatien
STE tmeselrmiandy -and thEtaiie oricTity cseligned reets the criterdz cctabliched.
Yrozdlzte . Suservicor 1 ddibeve]l Svrervicer b
James F. Gavin M. I. Kimball
SoETtEcnetedd

Etri e ~RE 17}
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g PR A s, A ThsaS doiie g 213G
Civildan Iz “Cyuee draatiayg I juest @

'

» Ezployee Name John J. Jordan Crade GS-9 Orgsnization Public Works
"Course Title NFCTC Design Contract Management DATES OF COURSE:
Length of Course 3 Days Location LANTNAVFACENGCOM

Exployees Last Official Performance Rating Outstanding

COST: Registration § O __Per Diem § 300.00 Tryye1 § 79.54 Total § 37°.54

1. Priority assigned to the training requirement.
v EE/ PRIORITX'ONQ -.gﬁﬁfﬁIIAL; Training required during:FY 1{§Z’that is considered
essentiil to uission accomplishment for one or more of the folloving rezsons:

Training needed to correct serfous performance deficfencies

T |

é 22/ Training required by law, regulation, or higher zuthority
il

o

Treining required for operztfon/mzintcnznce of ncw cquiprent

.
Trzindng required for c=ployces enrolled a2 tceognized forzel

* trzining progrem

/ PRJORITY W0 - NEEDZID: Treinlng vhich 4f rét funded rey frpzet czdvercely
cn co=plete zad quzlitctive ricsion gccozplishzent Curing the next & to
torece ficcel yeere, Erc-ple: Treining to previde for the eyctc=ctie

rcplzcezcnt of £ld1led e—ployees., .
[/ ><] PRICRITY TEPEE - USEFUL: Trzining of 2 brozdening ncture the richt be
LEelpful Ia exhzhciZng the overzll performcnce levels of c=ployces £lrczdy
ccasidered to be cornetent, This employee is responsible for administering
A/E Slate, Selection, and Negotiation Boards. Training is essential to ensure

2. rrovid@"meRd rseeins clnigewalianceswiths gl applicable, laws and regulations pertaining to

; ! e e r ; this function.
New duties assigned. Position Description being revised.

3. How zany of your employees have zlresdy received this or siriler trzining? None

4. VWhzt will be the fcpzst on the orgznization or explcyee if this training is
not recelived?
Proper contractural procedures for Architectural & Engineering Firm selection
and awardment may not be adhered to, making audit requirements difficult or
embarrassing.
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e L.C:ployce Name KAREN M. FOSKEY GS-7 Orgsnization public Works

Course Title DATES OF COURSE: peb. 9-13, 1987

A/C Design - Piping Systems

Length of Course 5 days Location

University of Wisconsin, Madison, WI

Ezployees Last Official Performance Rating Satisfactory

COST: Registration §790.00 Per Diem § 487.50  Travel § 382.00 Total § 1,659.50

1. Priority assigned to the training requirement<ns1:XMLFault xmlns:ns1="http://cxf.apache.org/bindings/xformat"><ns1:faultstring xmlns:ns1="http://cxf.apache.org/bindings/xformat">java.lang.OutOfMemoryError: Java heap space</ns1:faultstring></ns1:XMLFault>